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1 Introduction

1.1 Purpose

The purpose of this document is to describe SD / SDIO Host Controller 3.0. IP Integration
details.

1.2 Reference Document
e |P datasheet

1.3 Overview

SD/SDIO Host Controller interfaces the Microblaze through AXI4 bus and MiG Controller
through AXI memory mapped interface, enabling the data transfers between each other.
Microblaze IP will send the response to the SD host depending on the command issued and also
communicates with the MIG controller for Data read & write.

1.4 Acronyms and Abbreviations
Table 1: Acronyms & Abbreviations

Term Meaning
FPGA Field Programmable Gate Array
GPIO General purpose input output
FMC FPGA Mezzanine Card
LUT Look Up Table
10 Input and Output
FF Flip Flop
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2 IP Configuration and Instantiation

2.1 Example design
The SD/SDIO host controller IP example design mainly consists of

1. Microblaze soft core: User can provide the inputs to run the different tests using the bare
metal code running in the Microblaze. This will pass the different control signals to SD
host controller based on the user selection

2. SD/SDIO Host Controller IP: SD host controller IP takes the command given from the
microblaze soft core to the register set and with the ADMA the read and write operation
will happen from and to the SD Car0064

2.2 1P Configuration

The register set, ADMA configuration , tuning block , command and data path files are pre
synthesized. After synthesis the post synthesis file i.e., mmc_host.edn file is instantiated in the
design as shown in the Figure 1 . The SD Host controller with other files like the mmc_host.edn
file, mmc_host stub file, axi4_lite interface and the AXI memory mapped interface wrapper files
are added to make a user configured IP.

Sources ?
Q = % +
W Design Sources (2
« i 5. sd_host_controller (sd_host_controllerv) (5
® mmc_host_inst_9: mmc_host (mmec_hosty
mmc_host_inst_9 : mmc_host (mmc_hostedn
O axi4_native : axid_native (axid_native.
@ axi_mm_wrapper: axi_mm_wrapper (axi_mm_wrappery
@ axidmm_bridge ;. axidmm_bridge (axidmm_bridge .y

Figure 1:Design sources where SD host netlist is instantiated

Module sd_host_controller is the top module of the project which integrates the all the other files
(as shown in the Figure 1) to form a single IP.

Once the IP is generated make sure that the IP needs to be added in the block design of the
Vivado project 2020.1.
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Figure 2:SD_Host Controller added to the block design
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2.3 Steps to Instantiate SD HOST IP

1.

Install the required Vivado Design Suite 2020.1 for the host PC adding the license path.
https://www.xilinx.com/support/download/index.html/content/xil%09%09inx/en/downlo
adNav/vivado-design-tools/archive.html

Copy the project from “....\EMFC9_Release1.0_SD_3.0_Host\iW-EMFC9-PF-01-R1.0-
REL1.0\iW-EMFC9-FF-01-R1.0-REL1.0\iW-EMFC9-ED-01-R1.0-REL1.0\

iW_EMFC9 _REL_1.0\project_1” to your project directory in the host PC

Open the Xilinx Vivado tool 2020.1 and click on “Open Project” and select the required
project from the folder by clicking ok

Now the project selected will be opened in Vivado Design Suite 2020.1

Go to settings of Vivado 2020.1 and add the IP to the Project Settings = IP >
Repository—>then add the IP  path

' Settings =

IP > Repository
Project Settings Add directories to the list of repositories. You may then add additional IP to a '
Ceneral selected repository. If an IP is disabled then a tool-tip will alert you to the reason
Simulation
Elaboration IP Repositories

Synthesis +
Implementation
Bitstream naa
~ AP
Repository Mo content
FPackager
Tool setnas __Refresh All
Project
IP Defaults
» XHub Store
Source File
Display
WebTalk
Help
» Text Editor
3rd Party Simulatars
> Colors
Selection Rules
Shortcuts
> Strategies
> Window Behavior

ey
\zZ) Ok | Cancel | | Apply | | Restore

Figure 3:Adding SD_Host_controller IP to the IP repository

IP location is .\EMFC9_Releasel.0_SD_3.0_Host\iW-EMFC9-PF-01-R1.0-REL1.0\iW-
EMFC9-FF-01-R1.0-REL1.0\iW-EMFC9-ED-01-R1.0-REL1.0\ iW_EMFC9_REL_1.0\
project_1.srcs \sources_1 \IP .Add IP by clicking on the + sign as shown in Figure 3. After
the IP is added click on Apply and close the dialogue box

Once the IP is added in the project repository open the block design by clicking on mb

preset under top_module >mb_preset wrapper present in the source tab.

After adding the other IPs like Microblaze ,UART ,MIG Controller and Clocking
Wizard, add the SD host controller IP to the block design as shown in Figure 2 by
clicking on the + sign

iWave Systems Technologies Pvt. Ltd. Page 8 of 22
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2. Synthesize the block design first by validating the design(F6) and generate the output
products by right clicking on mb_preset under top_module >mb_preset_wrapper

present in the source tab and create HDL Wrapper

3. Instantiate mb_preset_wrapper in the top module with the ports and signals of block

design, in the top_module.v file as shown in Figure 4

mb_presst_wWrapps

moTaS T

.reset

.ddr3 sdram addr
.ddr3 sdram ba
.ddr3 sdram cas n
.ddr3 _sdram ck n
.ddr3 sdram ck_p
.ddr3_sdram cke
.ddr3_sdram cs_n
.ddr3_sdram dm
.ddr3 sdram dg
.ddr3 sdram dgs n
.ddr3 sdram dgs p
.ddr3 sdram odt
.ddr3_sdram ras_n
.ddr3_sdram reset n
.ddr3_sdram we n

LI3232_uart_rxd
L3232 _uart_txd

.2nakle o
amc_cd n i
mmc_clk_o
.mmc_dat_io
LImMC_ WP n i
.cind dir o
.cmd_in
.cind_out
.datal_dir o
.datal_3_dir o
.3y3_diff clock clk n
.3ys_diff clock clk p
.voltage 1 & slct o

Figure 4:Instantiation of block design 10 signals in the top module

{
{
{
{
{
{
{
{
{
{
{
{
{
{
{
{

e T e B e T e T e B e T i T e T e B T

r design_inst (

!reset

ddr3 sdram addr
ddr3_sdram ba
ddr3_ sdram cas n
ddr3_sdram ck n
ddr3 sdram ck p
ddr3_sdram cke
ddr3_sdram cs_n
ddr3_sdram dm
ddr3_ sdram dg
ddr3_sdram dgs n
ddr3_ sdram dgs p
ddr3 sdram odt
ddr3_sdram ras_n

ddr3_sdram reset_n

ddr3_sdram we n

r3232_uart_rxd
r3232_uart_txd

enable o
mmc_cd n i
mmc_clk o
mmc_dat_io
Imc_Wp n i
cmd dir o
cmd _in

cmd _out
datal_dir o
datal_3_dir_o

ays_diff clock clk n
ays_diff clock clk p
voltage 1 & slct o

4. The Constraint file (.xdc) provided in the design is for the Xilinx KCU105 Board. It

should be changed for custom boards other than Xilinx KCU105 Board

5. Give the required clock, Pin/IO constraints for SD host controller in the .xdc file and
compile the custom design with SD host IP

iWave Systems Technologies Pvt. Ltd.
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3 Implementation Details

3.1 Clock Domain

SD Host Controller 3.0 IP works on the SDR104 mode and the base clock mclk_i drives the
output clock to the SD card. User may need to adjust this clock between 104 MHz to 208 MHz
based on the hardware setup. In other words, if user gets CRC error with say 200 MHz, then user
can reduce the clock to say 190 MHz or below than to make sure write and read works fine with
that base clock.

mclk90_i is a phase shifted version of the mclk_i which is 200MHz and this clock is phase
shifted based on the response from the SD card. Phase Shift of 55° is added.

Idelay_ref clk_i is the fixed 200 MHz clock which will be provided for the IDELAY primitive
to be used for the tuning implementation block.

s_axi_clk_i or hclk_i which is 100 MHz which will be used for the communication between the
micro blaze and IP using the AXI4-lite interface for register access and AXI4-MM for DMA
access.

So to generate the all these clocks we give a 200MHz on board clock to MIG controller and 100
MHz is generated from the MIG and that is given to the clocking wizard to generate other
required clocks.

3.2 Constraints

3.2.1 Clock constraints:

The figure 5 shows the clock constraints used in this design. The constraints given here is
the system clock whose frequency is 300Mhz for Xilinx KCU105 board.

This constraint is added in the .xdc file. All other generated clocks will be automatically
handled by the Vivado tool since those are derived from the MMCM and will have
known relationship. User need to make sure there is no unconstrained clock in the design
by checking the clock network report in the Open implemented design from Vivado tool.

create clock -pericd 3.333 [get ports default sysclk 300_clk p]

Figure 5:Clock constraints

3.2.2 False path constraints:

The Figure 6 shows the false path in between all the clocks which is configured for the
SD host IP. This details will be available in the .xdc file.

set_false path -from [get clocks -of objects [get pins mb preset wrapper inst/mb preset i/ddrd 0/inst/u ddrd infrastructure/gen mmcme3.u mmeme adv inst/CLEOUTO]]
-to [get clocks -of cbjects [get pins mb_preset_wrapper inst/mb_preset_i/ddrd 0/inst/u ddrd_infrastructure/gen mmcmed.u mmeme adv_inst/CLECUTL]]

set_false path -from [get clocks -of_cbjects [get pins mb preset_wrapper_inst/mb_preset_i/ddrd 0/inst/u_ddrd infrastructure/gen mmcmed.u Dmcme adv_inst/CLEOUTL]]
-to [get clocks -of objects [get pins mb_preset_wrapper_inst/mb_preset_i/clk wiz_0/inst/mmcme3_adv_inst/CLEOUT1]]

set_false path -from [get_clocks -of ohjects [get pins mb_preset wrapper inst/mb_preset_i/ddrd 0/inst/u ddrd4 infrastructurs/gen mmcmed.u mmeme adv_inst/CLEOUT1]]
-to [get clocks -of cbjects [get pins mb preset wrapper inst/mb_preset_i/ddrd 0/inst/u ddrd_infrastructure/gen mmcme3.u mmcme adv_inst/CLEOUI0]]

Figure 6:False path constraints
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3.2.3 Pin Constraints:

Figure 8 shows the pin constraints in the .xdc file of example design.

set property
set property
set property
set property
set property
set property
set property
set property
set property
set property
set property
set property
set property

set property
set property
set property
set property
set property
set property
set property
set property
set property
set property
set property
set property
set property

FACKAGE FIN
FACKAGE FIN
FACKAGE FIN
FACKAGE FIN
FACKAGE FIN
FACKAGE FIN
FACKAGE FIN
FACKAGE FIN
FACKAGE FIN
FACKAGE FIN
FACKAGE FIN
FACKAGE FIN
FACKAGE FIN

IOSTANDARD
IOSTANDARD
IOSTANDARD
IOSTANDARD
IOSTANDARD
IOSTANDARD
IOSTANDARD
IOSTANDARD
IOSTANDARD
IOSTANDARD
IOSTANDARD
IOSTANDARD
IOSTANDARD

R13 [get ports {mmc dat ic[3]}]
Ji [get ports {mmc_dat_ic[2]]]
Ll2 [get ports {mmc dat ic[l]}]
L& [get ports {mmc_dat_ic[0]}]
K10 [get ports mmc_clk o]

F& [get ports mmc cmd ic]

Ell [get ports datal_dir o]
E10 [get ports datal 3_dir o]
L13 [get ports cmd dir o]

Jo [get ports wvoltage 1 5 _slect o]
D13 [get ports mmc cd n i]

Cl3 [get ports mmc wp n i]

H1% [get ports enabkle o]

LVCMOS1E [get ports [mmc dat ic[3]]1]
LVCMOS12 [get ports [mmc dat ic[2]]]
LVCMOS12 [get ports [mmc dat ic[l]]]
LVCMOS12 [get ports [mmc dat ic[0]]1]
LVCMOS12 [get ports mmc clk o]
LVCMO512 [get ports Irmu:_u:md_iu:]l
LVCMOS12 [get ports datal_dir o]
LVCMOS12 [get ports datal 3_dir o]
LVCMOS12 [get ports cmd dir o]
LVCMOS12 [get ports woltags_l 3 _slct_o]
LVCMOS12 [get ports mmc cd n i]
LVCMOS12 [get ports mmc wWp n i]
LVCMOS12 [get ports enable o]

Figure 7:Pin Constraints in example design .xdc file

NOTE: These constraints are in accordance to example design created for the KCU105
Evaluation kit and there is no need of adding the MIG/ DDR 10 pins, UART IO pins .
Define the constraints for clock, reset and UART pins accordingly for any other custom

board.

iWave Systems Technologies Pvt. Ltd.
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4 Test setup

4.1 Test requirements

Xilinx KCU105 dev kit

iIWave FMC daughter card

USB cables for JTAG and UART
SD card for testing

Power Supply 12 V

NOTE: iWave FMC card requires Vadj=1.8V for its operation. Please make sure that Vadj
=1.8V for iwave FMC daughter card from the user board.

4.2 Connections

Figure 8:Test Setup of KCU105 board with iw_FMC card

Please make sure that FMC card of SD connector interface is connected to HPC FMC of
Xilinx KCU105 board. Connect UART .There will be two serial port available one For
system control and other one for FPGA design(Debug_ UART). Select the port for system
control and observe the prints as shown in below figure. For example in example design

iWave Systems Technologies Pvt. Ltd. Page 12 of 22
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serial port 10 is for system control and serial port 9 is for FPGA design. System control is
used to set the FMC voltage in 1.8V

) o | Tera Term: Serial port setup
File Edit Setup Con

Port:
Baud rate:

Data:

Parity:

Stop:

Flow control:

Transmit delay

El msecichar El msecfline

Figure 9:Selecting Serial port to adjust voltage level

After Selecting the serial port check for tera term prints of KCU105 board as shown in
figure below.
COM®E:115200baud - Tera Term VT

File Edit Setup Control Window Help

KCU185% System Controller vl.B
— Main Menu —

. Set Programmable Clocks

. Get Power System (PMBUS)> Uoltages

. Get UltraScale FPGA System Monitor <S¥YSMON> Data
. Adjust FPGA Mezzanine Card (FMC) Settings

. Get GPIO Data

. Get EEPROM Data

. Gonfigure UltraScale FPGA
Select an option

Figure 10:Tera term prints in KCU105 board.

In main menu select option 4 i.e. adjust FPGA FMC settings. Then in FMC menu select
Option 4 i.e. Set FMC VADJ to 1.8V. as shown in the figure below.

iWave Systems Technologies Pvt. Ltd. Page 13 of 22
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W COMZ:115200baud - Tera Term VT
File Edit Setup Contrel Window Help

System Controller vli.B@
Main Menu —

- Set Programmabhle Clocks

- Get Power System (PMBUS)> Uoltages

- Get UltraScale FPGA System Monitor <(SYSMON> Data
1. Adjust FPGA Mezzanine Card (FMC)> Settings
b. Get GPIO Data

. Get EEPROM Data

- Configure UltraScale FPGA
EFelect an option

CU185 System Controller vli.B@
— FMC Menu -

CLOCKS
1I1C EEPROM
11C EEPROM
to 1.8U
to 1.5U
to 1.2U
to B.8Y
- Return to Main Menu
EFelect an option

Figure 11:FMC menu in KCU105

Please make sure that SD connector FMC card voltage is set to 1.8V and 2 Blue LED in
FMC card is glowing as shown in the Figure below.

o
T

(&&hﬂ 4 " ﬁﬁ T -
anso

Figure 12:SD Connector FMC

4.3 Programming FPGA and running using Vitis.

e After generating bitstream in Vivado 2020.1 go to File> Export hardware - select
Fixed click next = select include bitstream and click next = give the XSA file name
where you want to store your xsa and keep directory as local to project and click Finish

e Create a local folder in the Vivado Project folder and give that as workspace folder for
Vitis 2020.1 project and click ok

e After exporting the project go to tools in Vivado and give the path of the local folder
created as a workspace folder for Vitis (mentioned in step 2), click on launch Vitis IDE
as shown in Figure 11 a new window will appear

iWave Systems Technologies Pvt. Ltd. Page 14 of 22
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+J Eclipse Launcher >

Select a directory as workspace

Yitis IDE uses the workspace directory to store its preferences and development artifacts,

Workspace: F:\EMFCQ‘_RElEESE'I.D_SD_3.D_HDSt\SW1 R Browse...

[) Use this as the default and do not ask again
+ Restore other Workspace

+ Recent Workspaces

Figure 13:Launching Vitis 2020.1

e Once Vitis 2020.1 is opened then click on Create application project .Then click next,
Create a new platform from hardware(XSA)->give the .xsa file path by browsing to that
file where you had exported your xsa (project local folder)and click next ,give application
project name as shown in the below figure and click next

| ad Mew Application Project [m] =
Application Project Details
Specify the application project name and its system project properties
|
| Application project name: sd_host
System Project
Create a new system project for the application or select an existing ene from the workpsace (i ]
Select a system project S AR S EEE
||| e ——
System project name:  sd_host_systemn
Target processor
Select target processor for the Application project.
Processor Associated applications
microblaze_0 =d_host
]
i
D

Figure 14:Application project name

¢ In Available templates click on empty application and click on finish

e Once the project is open, copy the source code from the release folder
(...\EMFC9_Releasel.0_SD_3.0_Host\iWw-EMFC9-PF-01-R1.0-REL1.0\iW-EMFC9-
SF-01-R1.0-REL1.0\iW-EMFC9-SC-01-R1.0-
REL1.0\SD_HOST vitis_ REL_1.0\SW\source_vitis) to Vitis project src folder and then
Save (CTRL+S) and Build(CTRL+B) the project

iWave Systems Technologies Pvt. Ltd. Page 15 of 22
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NOTE: Copy only iwsd_hardware.h, iwsd_host_controller.h, iwsd_host_controller.c and
main.c from the release folder to the src folder present under the application project
e Then right click on project go to run and click run configuration ->system project debug
e In the appeared window under target setup click on reset entire system and program
FPGA as shown in the below figure

[2 Design %7 Debug

Mame: | SystemDebugger_sd_host test_system

Miain @ Torget Seup B Emironment ] Gomman

~ & System Project Debu
L, systembDebugger_sd_host_test_system

Hardware Platforms | ${sd TefLaunchFile:project= sd_host testfie Types ) Search.. Browse...

Bitstream File: S{project _test_ide/bitstream/top_module.bit Search.. Bpowse... Generate.

T sd_host_test system

Figure 15:Target setup in run configuration.

e Now click on Run
e After clicking on Run, FPGA will be programmed and board is test ready

NOTE: Before clicking on Run please make sure Xilinx KCU105 board is turned on with
JTAG connections, 12V power supply and proper tera term setup.

If program FPGA is done using Vivado 2020.1 please don’t select program FPGA option in
target setup Vitis 2020.1.
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5 Test Procedure

5.1 Tera term setup

e Open tera term in PC and select the com port other than COM1 (File> New
connection > Serial)

e Select baud rate as 115200 in setup ->serial port - Speed

5.2 Testing Procedure

5.2.1

After set up follow the below procedure to test the SD Host controller IP.

Initial prints:

Make the necessary connection to program the target FPGA board. Connect UART and

JTAG along with FMC Card of SD Connector interface to target FPGA board as shown

in the Figure 9 and do the Proper tera term setup.

After clicking on Run in Run configuration ,software will program the FPGA. Once the

programming is done and .elf file is executed, then below print will be displayed in Tera
term. Please wait for some time for the initial prints to be displayed.

M COM3:115200baud - Tera Term VT — O s

File Edit Setup Control Window Help

Welcome To iWave Demo Of SD Host Controller 3.8

Card Removed???

Waiting For Card To Be Inserted

Figure 16:Initial print after FPGA is programmed

As shown in the Figure 13 the application is waiting for the card to be Inserted , so insert
the card and then the check that the D5 Red led on the FMC card is glowing which
indicates that SD card is detected refer Figure 14, if that is glowing then the following
prints will come as shown in Figure 15

Figure 17:Card Inserted to FMC
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Welcome To iWave Demo Of SD Host Controller 3.8

Card Removed???
Waiting For Card To Be Inserted

Card Inserted

Driver version = 3

18570508689
1397124328
1193488383
275448028

CardIDI31]
CardIDI21]
CardIDI11]
CardIDIB]

card_size in Ghytes = 8 GB

8D initialization Successful?

SCR_STRUCTURE =
SGR_SD_SPEC
SCGR_DATA_STAT_AFTER_ERASE
SCGR_SECURITY
SCR_SD_BUS_WIDTHS

Card Supports 1 bit and 4 hit width

Data Width Selected : 2
Changing the bus width

Card Supports High Speed Mode
Getting bus speed pass?

Data transfer initiated at High speed Mode

Enter the following choice as needed and press enter:

1 —->» Basic UWrite Operation.

2 —> Basic Read Operation.

3 —-> Write and Read and compare internally and display the result as MATCHED or NOT Matched.

Figure 18:Card Initialization

As shown in the Figure 15 test case is available i.e.

1.
2.
3.

Basic Write Operation

Basic Read Operation

Write and Read and compare internally and display the result as Matched or Not
Matched

Any other test case than the mentioned above will result in wrong choice i.e.”
NOT Matched” as shown in Figure 16

Enter the following choice as needed and press enter:

1 ->» Bazic Weite Operation.

2 —-» Basic Read Operation.

3 -» Write and Read and compare internally and display the result as MATCHED ow
NOT Matched.

Entered Choice : 4

Select a valid option

Enter the following choice as needed and press enter:

1 -»> Bazic Write Operation.

2 -» Basic Read Operation.

3 -» Write and Read and compare internally and display the result as MATCHED om
NOT Matched.

Figure 19:Wrong choice
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5.2.2 Basic Write Operation:

e Basic write operation is the 1% testcase in the current design
e Enter the block count with minimum value of <“1” and maximum value of <1024”

e Enter the Start address in decimal, once the operation is completed successfully
then user gets the print “Write Completed”

Enter the following choice as needed and press enter:

1 -» Basic Weite Operation.

2 —» Basic Read Operation.

3 -> Uprite and Read and compare internally and display the result as MATCHED or NOT Matched.
Entered Choice : 1

Enter the block count value hetween 1 and 1824 inclusive.
Enter 1 for single hlock write.
Enter value greater than 1 for multiple block write.

Block Count Entered : 512

Address in decimal address
Start Address Entered : 1088

Writing incremental data to card.
Total Block count is: 262144
Write Completed

Figure 20:Basic Write Operation

5.2.3 Basic Read Operation:

e After initial prints, press “2” for basic Read Operation and then enter the block
count with minimum value of “1” and maximum value of “1024”

e Enter the block count and the enter the Start address from where the read
operation needs to be started, once the read operation is completed successfully
then user get the print “Read Completed.”

Enter the following choice as needed and press enter:

1 —-»> Basic Write Operation.

2 —» Basic Read Operation.

3 —» Write and Read and compare internally and display the result as MATCHED or NOT Matched.
Entered Choice = 2

Enter the block count walue hetween 1 and 1824 inclusive.
Enter 1 for single block read.
Enter value greater than 1 for multiple bhlock read.

Block Count Entered : 512

Enter the starting address (B to 312831799>.

Address in decimal
Start Address Entered : 1888

Total Block count is: 262144
Read Completed

Figure 21:Basic Read Operation

5.2.4 Write , Read and Compare operation:

e The 3" test case is Write and read back and compare and display whether it’s a
match or not match

e Enter the block count where the minimum value is “1” and maximum value is
“1024” enter the block count and then enter the Start address of the write and
read operation to start
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e Once the address is entered the Write to Card Operation will start and once the
operation is completed successfully then user gets the print “Write Completed,”
then Read from Card operation will start and print will be obtained same as in
write operation

e Write and read data is “Matched or Not Matched” print will be observed in the
Console

Enter the following choice as needed and press enter:

1 -> Basic Write Operation.

2 —» Basic Read Operation.

3 —>» Write and Read and compare internally and display the result as HATCHED or NOT Matched.
Entered Choice : 3

Enter the block count value bhetween 1 and 1824 inclusive.
Enter 1 for single block write.

Enter value greater than 1 for multiple block write.
Block Count Entered : 512

Enter the starting address (B to 31283199>.

Address in decimal
Start Address Entered : 1888

Writing incremental data to card.
Total Block count is: 262144
Urite Completed

Reading from the card.
Total Block count is: 262144

MATCHED
Read Completed

Figure 22:Write & Read Back and Compare

NOTES:
e The current base clock is running at 300 MHz which is the maximum clock that can
be used with KCU105 dev kit
e Block count up to 1024 is supported
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6 Design modification to be done for Custom Board

Update the FPGA part number/board according to the FPGA device used

Update the complete design for the selected FPGA device

Update the pin constraints for SD interface, clock, reset and UART pins

Update the clock constraint according to the input clock frequency for the selected FPGA
device

e Recompile the design to generate the new binaries and use the XSA file to create the new
application project in Vitis
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7 Resource Utilization

The table below shows the resource utilization summary for KCU105 dev. kit. for SD Host

Controller IP.

Table 2: Resource Utilization for device for SD Host Controller IP.

Resource Utilization Available
LUT 2532 242400
FF 2230 484800
BRAM 0 600
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